
Creating a DVD Disc with iDVD

One of the best ways to share your movies and pictures is to put them on a DVD disc. 
A single DVD disc can hold up to two hours of video, so you can put one long movie 
or several shorter movies on the same DVD.
 
With iDVD, Appleʼs application that lets you create your own DVDs, you can easily 
organize your movies on a disc. And using the professionally designed themes 
included with iDVD, your DVD will look like a Hollywood studio created it.

Introduction
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With iDVD, youʼll create a project file that youʼll use to organize all the different 
movies and photos you have on your disc. This way, you can assemble your DVD 
over time and create the disc when all the pieces are ready.

Creating a Project for Your DVD
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Create a project for your DVD

1: Click the iDVD icon in the Dock.

2: In the iDVD startup window, click Create a New Project.

3: In the Save window type a name for your project.

4: Notice that iDVD automatically chooses to save your DVD project in the 
Documents folder. Click the Where pop-up menu if you want to save your project to 
an alternate location.

5: When you are ready, click Create.

6: Notice the menu window that appears for your DVD. Double-click the title in the 
menu and enter a title for your DVD.

7: Save your project by opening the File menu and choosing Save.

Creating a Project for Your DVD : Step-by-Step
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Use OneStep DVD to burn a DVD directly from your video camera

There may be times when you donʼt want to go through the process of editing your 
movie and designing a DVD disc. Maybe you have footage of a play rehearsal that 
you want to share with the cast, or you have a movie on tape that you have previously 
edited and want to provide a copy on DVD. With OneStep DVD in iDVD, you can go 
straight from the tape in your video camera to a DVD disc. Simply connect your 
camcorder to your Mac and then choose OneStep DVD from the File menu.

iDVD supports wide-screen movies created in iMovie HD

DVDs from your favorite movies are often presented in a 16:9 wide-screen format, 
which matches the format the movie was presented in the theater on a screen that is 
much wider than it is tall. iDVD supports high-definition wide-screen movies created in 
iMovie or other video editing programs. When played from DVDs created in iDVD, 
wide-screen movies will maintain their wide-screen format.

Creating a Project for Your DVD : Useful Tips
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Create a iDVD project from within iMovie HD

From inside iMovie HD, you can quickly create a new iDVD project and automatically 
add the movie you are working on to the DVD. In iMovie HD, click the iDVD button 
and then click the Create iDVD Project button. iDVD automatically opens, creates a 
new project, and adds your movie.

Use iDVD on a computer that doesnʼt have a SuperDrive

If your Mac does not have a drive capable of burning a DVD (known as a SuperDrive) 
you can still use iDVD. Use iDVD to create your project, then open the File menu and 
choose Save As Disc Image.

Creating a Project for Your DVD : Useful Tips
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Changing the name of your project

The name you give to your iDVD project is the name that iDVD assigns to the disc 
when you create it. Youʼll see this name appear on your computer when you insert the 
disc, and it may also appear on the display of certain DVD players. If you want the 
disc to have a different name than the name of your project, open the Project menu 
and choose Project Info. Type a new name for your DVD and then click OK.

Creating a Project for Your DVD : Useful Tips
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Each menu on your DVD can have its own look, known as its theme. And with the 
professionally designed themes that come with iDVD, you can make your DVDs look 
like they were created by a Hollywood studio.
 
iDVD comes with many themes. In some, youʼll see an area with the words “Drop 
Zone.” These are special parts of the menu where you add your own pictures or 
movies, and have them incorporated into the menuʼs background, giving your DVD a 
professional appearance that still has your personal touch.

Choosing a Theme for Your DVD
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Select a theme for your DVD and add your own pictures and movies to the menu drop 
zones

1: In iDVD, click the Customize button.
2: In the drawer that appears, click the Themes button.
3: Click on different themes in the list until you find one you like that has drop zones.
4: To add items to a drop zone, open the Project menu and choose Edit Drop Zones.
5: Notice how the iDVD window changes to show the Drop Zone editor, and the 
Customize drawer shows photos from your iPhoto library.
6: Select a photo and drag it to an empty drop zone.
7: Click the pop-up menu again and choose Movies.
8: Notice your movies appear in the drawer. Select a movie and drag it to another 
drop zone.
9: Repeat this process until all of the drop zones have items in them.
10: Click the Return button in the lower-right corner to leave the Drop Zone editor and 
return to the menu.

Choosing a Theme for Your DVD : Step-by-Step
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Add a group of photos to a drop zone

You can incorporate a series of photos into any of your menu drop zones. The drop 
zone will cycle through the group of pictures. To add a group of photos, simply drag 
an album to the drop zone. Drop zones with multiple photos display a small picture 
icon in the lower right corner of the image.

Change the contents of a drop zone

The Drop Zone editor makes it easy to change the contents of a drop zone. To 
remove an item, simply drag it out of the Drop Zone Editor. Double-click a drop zone 
and youʼll see another window that lets you add, delete, or rearrange the contents of 
the specific drop zone.

Choosing a Theme for Your DVD : Useful Tips
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Manually move around in a motion theme

There may be times when you want to temporarily turn off the motion in your theme 
so that you can review a part of it. You can turn the motion off and on by clicking the 
Motion button in the iDVD window. You can also scrub back and forth using the 
motion playhead at the bottom of the theme. If the playhead is not visible, youʼll need 
to turn it on by opening the Advanced menu and choose Show Motion Playhead.

Identifying themes with motion

As you browse through the available themes, youʼll notice that some themes display 
images that change, and others play music. Themes with motion are known as 
“motion menus” and display the small motion icon in their lower-right corner.

Choosing a Theme for Your DVD : Useful Tips
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Turn the theme intro off and on

With certain motion themes youʼll notice a checkbox to the left of the motion 
playhead. You may also notice a small divider line in the motion playhead timeline. 
The portion to the left of the divider line is the introductory portion of the menu that 
only plays the first time the menu is activated. The portion on the right is the looping 
portion of the menu. The checkbox determines whether or not the introductory portion 
is shown in the menu.

Make sure to look at all of the iDVD themes

iDVD comes with many themes to choose from, including themes from the previous 
versions of iDVD. Open the pop-up menu above the list of themes to see the other 
theme sets available. In addition to the themes that come with iDVD, other companies 
create themes for iDVD.

Choosing a Theme for Your DVD : Useful Tips
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Drag an item directly to a drop zone

There may be times when you want to quickly change the contents of a drop zone. 
Instead of opening the Drop Zone Editor you can simply drag a photo, group of 
photos, or movie, from the media browser (or directly from iMovie or iPhoto) to a drop 
zone in a menu.

Choosing a Theme for Your DVD : Useful Tips
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Once you have selected a theme for your DVD and personalized it with your own 
items, it is time to add movies.

Adding Movies to Your DVD



Creating a DVD Disc with iDVD

Add movies to your iDVD menu

1: Click the Customize button in the iDVD window.
2: At the top of the drawer that appears, click the Media button.
3: From the pop-up menu below the Media button, choose Movies.
4: Drag the movie you want to add to the iDVD window.
5: Notice how the name of the movie appears in the window. Click the name to select 
it and then change the name to the name you want to appear in your DVD menu.
6: Double-click the title to see a preview of the movie in the window. Click in the 
movie again to return to the menu.
7: Save your iDVD project.

Adding Movies to Your DVD : Step-by-Step
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Understanding how many movies you can add

One of the best things about a DVD is that it can hold lots of movies, which gives your 
audience lots of choices. You can add up to 12 movies to any iDVD menu. If you have 
more than 12 movies you can just create another menu. In fact, you can add as many 
movies as your disc will hold up to 99 movies.

Preview your movies before adding them

In the movies section of the iDVD media browser, youʼll see the title along with a 
small preview image for each of the movies in your Movies folder. The title and image 
help you make sure you are adding the right movie to your project. If you are not sure, 
simply double-click an image to see a preview of the movie. Click the movie to stop 
the preview at any time.

Adding Movies to Your DVD : Useful Tips
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Search for movies in other locations

iDVD automatically locates any iMovie projects or QuickTime movies you have stored 
in the Movies folder in your home folder. If you store movies in another location, such 
as an external hard disk, you can set iDVD to search there. In iDVD Preferences, 
click the Movies button and then click the Add button to choose additional locations. 
You can also drag a folder from the Finder into the iDVD movie browser.

Adding movies created in other applications

To add a movie created in another application to your iDVD project, you need to 
export it as a QuickTime movie. Any movie in QuickTime format can be added to an 
iDVD project, but for best results, export the movie as a self-contained DV (digital 
video) file.

Adding Movies to Your DVD : Useful Tips
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With iDVD, you can create slideshows from your digital pictures to make your DVD 
more interesting. For example, on a family reunion DVD, you could make your story 
complete by including video from the reunion, and a slideshow of family photos.
 

Inside iDVD you have access to all the photos from your iPhoto library. You can set 
how long each photo appears onscreen, add transitions between pictures, and even 
add music from your iTunes library.

Adding a Slideshow to Your DVD
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Create a slideshow set to music

1: Click the Slideshow button at the bottom of the iDVD window. Notice the new 
button that appears.
2: Give it a name and then double-click the title to open the slideshow window.
3: Click the Media button at the top of the Customize drawer, open the pop-up menu 
below it, and then choose Photos.
4: Select one of your photos, and then drag it to the slideshow window. Or drag an 
entire album to copy multiple pictures.
5: From the Transition pop-up menu at the bottom of the slideshow window, choose a 
transition style.
6: From the pop-up menu below the Media button, choose Audio.
7: Select a song or playlist from your iTunes library, and then drag it to the audio well.
8: Click the Preview button to see your slideshow in action. Click Preview again to 
exit.
9: Click Return to go back to the DVD menu.

Adding a Slideshow to Your DVD : Step-by-Step
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If you want to change your slideshow

At any time, you can add additional images to your slideshow. You can also rearrange 
the order of your pictures by dragging them around in the window. To delete a slide, 
simply select it and then press the Delete key. To remove an audio clip, drag it from 
the audio well to the Trash icon in the Dock.

Change how long slideshow images appear onscreen

In the slideshow window, open the Slide Duration pop-up menu to see the settings 
available for your slideshow. You can set the slides to stay onscreen for a specific 
amount of time or to match the duration of the audio clip you added. You can even set 
the slideshow so that the viewer can use the arrow keys to move between images.

Adding a Slideshow to Your DVD : Useful Tips
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Set up your photo slideshows ahead of time in iPhoto

iDVD automatically recognizes any albums youʼve created in iPhoto. In addition, iDVD 
will recognize any transitions or music youʼve set for the slideshow. Simply drag the 
photo album to a DVD menu, and iDVD will automatically create a slideshow with the 
same photos, music, and settings that you set up in iPhoto.

Set your slideshow to loop

DVD discs are often set up in areas where they are constantly playing. For example, 
a DVD might be used to show product information on a television screen at a store. 
You can easily set up your slideshow to continually loop until someone clicks the 
menu button on the remote control.

Adding a Slideshow to Your DVD : Useful Tips
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Choose whether you want your pictures displayed full screen

Because the outer portion of the DVD video may not be visible on certain televisions, 
iDVD automatically sizes pictures down to match an area known as the TV Safe Area. 
On televisions capable of displaying outside the TV Safe Area, the image will simply 
appear centered on a black background. To prevent iDVD from scaling the image, go 
to iDVD preferences, choose Slideshow, and make sure the “Always scale slide to TV 
Safe area” option is not selected.

Adding a Slideshow to Your DVD : Useful Tips
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You are not limited to including only a couple of movies or slideshows on your DVD. 
In fact, most people create many small movies and slideshows instead of one big 
one. Instead of creating a separate disc for each item, you can store them all on one 
disc. Imagine being able to store all your movies and photos from the past year on a 
single disc.

 
If your DVD disc includes only a few items, youʼll probably need only one menu. If it 
has more than 12 items, youʼll need to create multiple menus on your DVD. You can 
create a hierarchy of menus that will keep your screen from becoming cluttered—your 
audience will appreciate that. In iDVD, you do so by adding folders. A folder is simply 
a way to add another menu to your DVD disc.

Adding Additional Menus



Creating a DVD Disc with iDVD

Add a menu with additional movies

1: Click the Folder button at the bottom of the iDVD window. Notice the new item titled 
“My Folder” that appears in the window.

2: Click the folderʼs title, and then type a new name.

3: Double-click the folder to open it and notice the new menu.

4: Select a different theme for the menu.

5: Add additional movies and slideshows to this menu.

6: Click the Back arrow to return to the previous menu, and then save your iDVD 
project.

Adding Additional Menus : Step-by-Step
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Quickly create a new menu

If you have several items in a menu and then decide you want to move them to a 
separate menu, you donʼt have to delete them and add them to a new menu. Simply 
select the items while holding down the Shift key, open the Project menu, and then 
choose New Menu from Selection.

Apply theme changes to an entire project

If you change one menuʼs attributes, such as its button style, you may want to change 
all of the menus. From the Advanced menu, choose whether you want to apply the 
theme to the entire project or just to menus inside a specific folder.

Get a quick overview of the menus in your project

As you create additional menus and other items in your DVD, you may want to get an 
overview of the entire contents of your DVD. Click the Map button at the bottom of the 
iDVD window. Youʼll see a chart that shows all the items on your DVD. To access a 
specific item, double-click it in the map view.

Adding Additional Menus : Useful Tips
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Many professionally made DVD discs have a menu that lets you jump to specific parts 
of the movie. These menus are often referred to as chapter or scene selection menus.
 

In iMovie, you can specify scenes in your movie by including chapter markers. By 
doing so, a scene selection menu will automatically be created when you add your 
movie to iDVD.

Working With Chapter Markers
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Create chapter markers and add your movie to an iDVD project

1: With an iMovie project open, click the Timeline Viewer button.
2: Move the playhead to where you want to place the first chapter marker.
3: Click the iDVD button.
4: Click the Add Chapter button. Notice the item that appears in the iDVD Chapter 
Markers list.
5: Double-click the chapter marker to select it, and then type its title.
6: Repeat the process, adding several more chapter markers to your movie. Notice 
the small yellow diamond chapter markers added to the timeline viewer.
7: Save the movie and then open your iDVD project.
8: Drag the movie into a menu that already contains items. Notice that an entry for 
your movie and one titled “Scene Selection.”
9: Double-click the Scene Selection item. Youʼll see a button for each of the scenes in 
your movie.

Working With Chapter Markers : Step-by-Step
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How many chapter markers can you add?

You can add up to 99 chapter markers in any movie. If you add more than 99 chapter 
markers, youʼll be unable to add the movie to your iDVD project. To remove a chapter 
marker, select it and then click the Remove Chapter button in the iDVD pane of 
iMovie.

Update an existing movie with chapter markers

If you add or delete chapter markers in a movie that is already part of an iDVD 
project, youʼll need to delete the movie and then re-add it to the project. To remove a 
movie from your iDVD project, select the movieʼs button, and then press the Delete 
key.

Working With Chapter Markers : Useful Tips
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Notice the image assigned to the chapter marker

When you create a chapter marker, iMovie automatically assigns an image to it. This 
image is the movie frame where you placed the marker. You can set this image to 
appear on the scene buttons in the scene selection menu in iDVD.

Determine whether a scene selection is created

With iDVD you have the option to determine whether or not a scene selection 
submenu is created when you add a movie to an iDVD menu. In iDVD preferences, 
click the Movies button. The options available let you choose to have the submenu 
automatically created or to have iDVD ask you when adding a movie.

Working With Chapter Markers : Useful Tips
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Movies exported in QuickTime format may lose their chapter markers

If you export an iMovie project as a QuickTime movie using the Full Quality option, 
iMovie HD doesnʼt include chapter markers in the QuickTime movie. To export your 
movie with chapter markers, use the Create iDVD Project button or click the iDVD 
button in the Share window.

Working With Chapter Markers : Useful Tips
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As your DVD gets more and more complex with multiple menus, there may be times 
when you want to see an overview of the entire project.
 

The iDVD map view gives you a high level overview of your entire iDVD project. You 
can see which menus link to which movies, and jump directly to a specific menu, 
slideshow, or movie. You can even make changes to parts of your DVD project 
directly in the map view.

Working in the iDVD Map View
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Practice using the iDVD map view

1: Click the Map button at the bottom of the iDVD window. Notice the iDVD map view 
appears.
2: Click the buttons in the bottom left of the map view to change between a horizontal 
and vertical view of your project.
3: Use the slider at the bottom of the window to zoom in on your project.
4: With the map view zoomed in on your project, position the cursor inside the map 
view. Notice how it changes from a pointer to a hand.
5: Click and drag to move around in the map view.
6: Double-click an item in the map view to go directly to it.
7: To exit the Map view click the Return button in the lower-right corner of the map 
view.

Working in the iDVD Map View : Step-by-Step
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Creating a DVD with a movie that plays automatically

iDVD lets you create a movie that plays as soon as the user puts the disc into a DVD 
player. In iDVD, this process is known as creating an AutoPlay movie. In the iDVD 
map view, youʼll notice the item at the top of the map labeled “Drag content here to 
automatically play when the disc is inserted.” Just drag a movie or slideshow to it and 
the movie or slideshow will start playing as soon as the disc is inserted.

Collapse items in the map view

The iDVD map view lets you hide and show whole sections, making it easier to 
visually keep track of complex projects. Click the small triangle next to an item in the 
map view and watch as all items below it disappear. Click it again to have them 
reappear.

Working in the iDVD Map View : Useful Tips
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While youʼre working on your iDVD project, you can preview it at any time. When you 
preview your project, youʼll see it appear in the iDVD window. Youʼll also see the iDVD 
remote control, which lets you control the DVD just as if you were using the remote 
control for your DVD player.

Previewing Your DVD
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Preview your DVD disc

1: Make sure your iDVD project includes several movies, a slideshow, and at least 
one additional menu.

2: In the iDVD window, click the Preview button. Notice the remote control that 
appears.

3: Use the arrow buttons on the remote control to select menu buttons.

4: To play a movie or slideshow, select its menu button, and then click the Enter 
button on the remote control.

5: Click the Menu button on the remote control to return to the menu.

6: Click the Exit button on the remote control to exit the preview.

Previewing Your DVD : Step-by-Step
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If you donʼt see motion in the menu or hear music

If a menu is supposed to show motion or play music but itʼs not doing so, make sure 
the Motion button in the iDVD window is selected. The button allows you to turn 
motion and sound off for all your DVD menus.

Use the Title button if your DVD has multiple menus

If your DVD has multiple menus, you can always click the Title button in the remote 
control to go to the main menu. The main menu is the one that appears when you first 
insert the disc into the DVD player.

Try out your chapter markers

When previewing your iDVD project, you can use the Next and Previous buttons to 
skip between chapters in a movie. This way, you can test your chapter markers.

Previewing Your DVD : Useful Tips
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DVDs, including those you play in your DVD player at home, are simply large discs. In 
addition to storing and playing video, DVD discs are used to transfer large files from 
one computer to another. In fact, many DVD discs produced in Hollywood also 
include files that you can view on your computer, often referred to as the DVD-ROM 
contents of the disc.
 

With iDVD, you can easily add files to a disc in addition to your movies and 
slideshows, allowing you to create a multipurpose disc. For example, on a disc 
advertising a new product, you could include the product specification sheets.

Adding Additional Files to Your DVD
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Add a folder of documents from your hard disk to your DVD

1: Assemble the files you want to add into a folder on your hard disk.

2: With your iDVD project open, open the Advanced menu and choose Edit DVD-
ROM Contents.

3: In the window that appears, click the Add Files button and then choose the folder 
you created.

4: Repeat the process, selecting either individual files or folders you want to add to 
your DVD.

5: When you are finished adding items, close the DVD-ROM contents window.

6: Save your iDVD project.

Adding Additional Files to Your DVD : Step-by-Step
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Organize the DVD-ROM contents

The structure you set up for the files and folders in the DVD-ROM contents window is 
the same as what users will see when they put the disc in their computer. You can 
move files around and even create additional folders to help keep things organized.

Deleting items from the DVD-ROM

You can easily delete a folder or file from the DVD-ROM portion of the disc. Simply 
select the file in the DVD-ROM contents window, and then press the Delete key on 
the keyboard.

Adding Additional Files to Your DVD : Useful Tips
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Include the slideshow images on the DVD disc

Pictures you include in a slideshow are converted to video so that they can be viewed 
on your television. Because of this, you will not be able to open or edit the pictures on 
your computer. If you want to provide the original slideshow image files on the DVD 
disc, select the “Add original photos on DVD-ROM” option in the slideshow window. 
This way, your audience can not only watch your DVD on television, but they can also 
copy your photos to their computer, for example.

Add a link to the Internet on your DVD disc

Itʼs often useful to add to your DVD disc a link to a specific website where people can 
go for more information. In the DVD-ROM contents of the disc, include a file that is a 
link to a website. Go to the website you want to link to, and then drag the URL to your 
desktop, which creates a file that links to that web page. Then add the file to the DVD-
ROM contents of your disc.

Adding Additional Files to Your DVD : Useful Tips
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Using the built-in themes is a quick way to create a menu for your DVD disc. 
However, there may be times when you want to have more creative control over the 
appearance of your menus.
 

With iDVD, you have complete control over all aspects of your DVD menus, including 
text style and position, button style, and background images and movies.

Customizing Your DVD Menu
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Change the style of your menu

1: Create a new menu for your DVD disc and choose a theme that has large buttons.
2: Add several movies and slideshows to the menu. Notice that the buttons appear 
with an image instead of just text.
3: Click one of the buttons and notice the slider that appears above the button.
4: Use the slider to change the item that appears on the button. Repeat the process 
for each of the buttons in the menu.
5: Click the Settings button at the top of the Customize drawer.
6: Use the options in the Text section to change the style of the text in the menu.
7: In the Button section, click the From Theme button and change the style of the 
buttons.
8: Select Free Position and then drag the buttons where you want them.
9: Save your iDVD project.

Customizing Your DVD Menu : Step-by-Step
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Adding additional text to a menu

Many professionally created DVDs use menus to display additional information such 
as an actorʼs bio or list of other films. These menus often display only text. In iDVD, 
you can add text to any menu. Simply open the Project menu and choose Add Text. A 
text block will appear in the menu. You can then add your own text, change the style, 
and even position it wherever you want.

Add a transition when leaving a menu

You can set a transition (such as page peel or water droplet) to occur when you leave 
a menu to play a movie or slideshow or go to another menu. In the Settings view, 
open the Transition pop-up menu and choose the transition that occurs when leaving 
the menu.

Customizing Your DVD Menu : Useful Tips
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Save your custom theme as a favorite

When you save a custom theme as a favorite, you can easily apply it to new menus 
you create in existing or new iDVD projects. In the Customize drawer, click the Save 
as Favorite button at the bottom of the Settings section. From the pop-up menu in the 
Themes section, choose Favorites to see your custom theme.

Add your own photos, music, or movies to a menu

A fun way to get creative with your menus is to change the background. You can 
easily drag a photo or song into a menu and make it the background of your menu. To 
add a movie to the background of a menu, simply select the movie as if you were 
going to add it to a menu, but then drag it and hold it over the Settings button at the 
top of the window. When the view changes, drop the movie into the Background well 
in the Settings view.

Customizing Your DVD Menu : Useful Tips
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Check the position of your buttons and title

The outer area of your DVD menu may not be visible on some televisions. To see an 
approximation of how your DVD will look on most television sets, open the Advanced 
menu and then choose TV Safe Area. Make sure your buttons and titles appear within 
the white area.

Use the map view to set transitions for a menu

The iDVD map view provides an easy to set transitions for menu. With the map view 
visible, click a menu to select it. In the Settings section of the Customize drawer, use 
the Transition pop up menu to change the selected transition. Also notice that items 
below a menu with a transition attached to it display a small blue dot.

Customizing Your DVD Menu : Useful Tips
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Once your DVD project is just right, itʼs time to put it on a DVD disc. This process is 
known as burning the disc. The time required to burn a disc depends on the amount 
of video youʼre copying, and the speed of your computer.
 

Once your DVD has been created you can put the disc into the DVD player you have 
connected to your television and enjoy you creations on the big screen.

Creating Your DVD Disc
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Create a DVD disc and try it out.

1: Start with an iDVD project that you want to burn to a DVD disc.

2: In the iDVD window, click the Burn button, and then click the flashing Burn button 
when it appears.

3: When prompted, insert a blank DVD disc.

4: Watch as your iDVD project is copied to the DVD disc. When the project has been 
copied, iDVD automatically ejects your DVD disc.

Creating Your DVD Disc : Step-by-Step
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Try watching your new DVD on your Mac

After youʼve created your DVD, youʼll want to watch it. Try it out on your Mac using 
the DVD Player program. DVD Player opens automatically when you insert a DVD.

Creating a disc image from your project

Instead of burning your project to a DVD disc, you can create a disc image. Saving a 
disc image of your project means creating a file that is formatted just like a finished 
DVD, except it is stored on your hard disk instead of DVD disc. Having a disc image 
allows you to easily burn DVD discs without having to save your entire DVD project. 
You can even use a disc image to play your DVD on your Mac. Simply double-click 
the disc image to open it. (Youʼll see it appear as an item in the Finder sidebar). Then 
open the Applications folder and double-click DVD player.

Creating Your DVD Disc : Useful Tips
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Burn your project on another Mac

If your Mac does not have a drive capable of burning a DVD (known as a SuperDrive) 
you can still use iDVD. Use iDVD to create your project, then open the File menu and 
choose Save As Disc Image. All the items that make up your DVD will be packaged 
together, allowing you to transfer it to another computer where you can burn it to a 
DVD.

If you plan to create multiple discs

When iDVD finishes burning a disc, it ejects the disc. At that point, iDVD prompts you 
to put in another disc, if you want to burn another one. iDVD burns subsequent discs 
more quickly than the first one because your video has already been converted to the 
proper format for copying.

Creating Your DVD Disc : Useful Tips
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Make sure to have enough free hard disk space

Before burning your DVD, be sure to have at least twice as much free space available 
on your hard disk as your project size, to allow for encoding and burning. Check the 
DVD Capacity meter in the Status pane of the Customize drawer to determine the 
size of your project. For example, if you project uses 4.0 GB, you need at least 8.0 
GB of free space on your hard disk.

Creating Your DVD Disc : Useful Tips


